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NWOET Tech Conference + 2005
Are you looking for ways to weave technology into your lessons? Join us this year at the

NWOET Technology Conference and hear ways area specialists and teachers are using
technology in their classrooms. Featured keynotes this year are Paul Reinhart, fifth grade

teacher in the Bowling Green City School District, who was Ohio’s first-
ever Technology Teacher of the Year in 2002. Also speaking will be Bowling
Green University Professor, Dr. Rachel Vannatta, who has worked extensive-
ly with integrating technology in teacher education and the K-12 classroom.
She co-authored the article, “Beginning to Put the Pieces Together: A
Technology Infusion Model for Teacher Education,” which won the ISTE
2001 SIGTE Outstanding Research Paper of the Year Award. This article
describes her work as co-director with Project PICT (Preservice Infusion of
Computer Technology), a project funded by a three year federal grant.

This year’s conference will be held on Monday, October 10, 2005, at
Northwood High School in Northwood, Ohio. Conference sessions will run
60 minutes with a variety of 2-hour hands-on sessions. Featured sessions
include: Using Photoshop Elements to Enhance Desktop Publishing, Using
Digital Cameras in the K-12 Classroom, Security Issues – How Secure Are
You? Ohio Achievement with Technology and more. Check the conference
Web site after September 26 for a complete listing with descriptions of all
sessions. <www.nwoet.org/conference/presenters.htm>

Teachers have the option of earning contact hours which can be applied
toward their (IPDP) Instructional Professional Development Plan. Graduate credit is also an
option by attending two additional sessions of NWOET hands-on technology skill modules
offered on Monday evenings, September 12 through December 5, 2005.

Get excited about teaching and register today by filling out the online registration form
<www.nwoet.org/conference/register.asp> or by calling the toll-free number at 800-966-9638. NWOET Tech

Conference: A Call For
Presenters

Proposals for presentations are being
accepted until September 15, 2005. If you
are interested in presenting and sharing with
others how technology can be a valuable
tool in the classroom, please complete the
online proposal form <www.nwoet.org/
conference/presenters.htm>.

Paul Reinhart

Dr. Rachel
Vannatta

Effective Standards-
based Teaching:
Focus On Science 7-12
Cosponsored by Northwest Ohio
SERRC and NWOET

Students will attend 2 or 3 face-to-face
classes, as well as explore a different area of
science each week online. Participants in this
course will be provided 45 hours of science instruction when taking the course for one
or three credits or on a non-credit basis. This course is designed to lead to highly
qualified teacher status in science, but alone may not earn an educator highly qualified
teacher status in science. Consult your district administration.

SESSION I: 1 or 3 credit hours: Sept. 13 - Nov. 16, 2005
SESSION 2: 1 or 3 credit hours: Oct. 12 - Dec. 15, 2005
LOCATIONS: NWOET, plus additional locations depending on enrollment
INFORMATION: See page 4 & 5 or call NWOSERRC at 800-346-6495

We Have A Winner!!!
Alice Puls, a  teacher at Olney Elemen-

tary School, Northwood, is the winner of a
digital camera from the Media Center.
There will two more drawings this year for
prizes. Be sure to fill out the forms that are
included with the media. This could
happen to you.

Congratulations, Alice!!
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Congratulations To This Year’s News Six Schools
Another News Six Season Starting SOON!

District School Teacher(s)

Bellevue City Ridge Elementary School Sandy Ray

Continental Local Continental Middle School Lori Allen

Fremont City Atkinson Elementary School Chris Ward
Ben Ohlemacher

Montpelier Exempted Superior Middle School Shirley Sostoi
Village David Miller

Chip Etter
Jason Johnston

Ridgemont Local Ridgemont Elementary School Theresa Vigansky
Pam Robinson

Toledo Diocese Our Lady of Lourdes (Toledo, Ohio) Bonnie Chudzinski

Toledo Diocese St. Aloysius (Bowling Green, Ohio) Michele Stansley

Van Wert City Ohio City Elementary School Cindy Good
Cheryl Bebout

Wauseon Exempted Burr Road Middle School Mark Britsch
Village Shelly Day

Wayne Trace Local Grover Hill Elementary School Mike Bok
Sharon Peck

The News Six programs will be aired starting in January 2006 or sooner. Confirmed air
dates and times will be published in an upcoming SCANNER publication and posted on
our News Six Web page. Be sure to tune in to see the stories reported by sixth grade
students from around Northwest Ohio  These stories will also be available for viewing on
the News Six Web site located at <www.nwoet.org/newsix/>. Stories created and produced
by last year’s News Six participants will be available for viewing until the new stories are
published.

News Six Repeats
We will be broadcasting News Six

from the 2004-2005 season on Wednes-
day 1:00 - 1:10 p.m. and Thursdays from
2:20 - 2:30 p.m. starting in September
and running until the new season begins
in January 2006.

St. Bernard 9/13, 9/14
(New Washington)

Vanlue 9/20, 9/21

Lakota East 9/27, 9/28

Wapakoneta 10/4, 10/5

Gateway Middle 10/11, 10/12

Elmwood Middle 10/18, 10/19

Lima North 10/25, 10/26

Paulding Middle 11/1, 11/2

St. John Lutheran (Napoleon) 11/8, 11/9

St. Mary (Tiffin) 11/15, 11/16

2005-2006 Holiday
Closings
September 2, 2005 (Limited Services)

Labor Day – September 5, 2005

Veterans’ Day – November 11, 2005
(Fri.)

November 23, 2005 (Limited Services)

Thanksgiving – November 24 & 25,
2005

Christmas – December 23 – Jan 2, 2006

Regular office hours will resume on
January 3, 2006, Monday – Friday,
8:00 a.m. to 4:30 p.m.

BGSU Tech Fair For High School And College
Students
Date: Thursday, November 10, 2005
Time: 10a.m. - 3p.m.
Place: BGSU’s Bowen-Thompson Student Union Lenhart Grand Ballroom

Northwest Ohio students have the opportunity to view the latest new innovations in
technology at the Bowling Green State University Technology Fair Thursday, Novmber 10.
Designed with high school and college students in mind, the event, open to the public, will
feature dozens of demonstrations and exhibits. Teachers are encouraged to bring their
classes to the fair, which will run from 10 a.m. to 3 p.m. in the Student Union.

High schools may also win prizes. In the Technology Fair Web Design Contest, the
intent is to promote and recognize high school student interest in Web-based technology in
Northwest Ohio, according to Duane Whitmire, Director of BGSU’s Student Technology
Center.

For more information, go to our Web site at <www.bgsu.edu/offices/studenttech/
techfair/>. Categories, prizes and rules for the web contest are listed at <www.bgsu.edu/
offices/studenttech/techfair/webcontest.html> .
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Implementing The Ohio Technology Standards: What One School
Has Done!
By Donna Dick

The Ohio technology standards were adopted in 2003. Implementing these standards will enable students to achieve the No Child Left
Behind eighth grade technology literacy requirement, which states that “by 2006 every eighth-grade student in the United States must be
proficient in technology literacy skills.” The Ohio standards include seven standards representing technology content that all students
should know and be able to do as they progress through kindergarten through twelfth grade. The technology standards are written to be
imbedded with the content of other curricular areas. Combining technology with other subjects, such as math, science and social studies
helps students with their understanding of content. Some of the technology standards tend to blend in or mesh nicely with specific content
areas. For example, Standard 5, technology and information literacy, which has to do with use of technology and research, blends in nicely
with many of the language arts standards. Implementing the Ohio technology standards seems like a daunting task.  How are Ohio districts
implementing the Ohio technology standards?

One Ohio school district, the North Canton City Schools, developed a “Technology Standards Implementation Tool” that was used to
evaluate where each grade level was with technology integration in relation to the Ohio technology standards and the academic content
standards. This tool puts the Ohio technology standards in a spreadsheet by grade level. See example below. Each technology standard,
benchmark and learning outcome is listed in the first column. A district looks at each standard and fills in the appropriate information.

A: We are currently doing this standard as part of an approved course of study.

B: We should implement this standard and can do so with the current resources (staff, courses, technology) available.

C: We should implement this standard but need more resources (staff, courses, technology) to do so.

D: We not not feel this standard needs to be implemented at this time.

Comments: General information about the implementation of the standard.

Resources: What staff, courses, or technology can be used or is needed for this standard.

Connections: What Ohio academic content standards (math, science, language, social studies, etc.) does this technology standard relate to?

Grade 6 A B C D Comments Resources Connections

Standard 5
Technology and Literacy

Benchmark B:
Use technology to conduct
research and follow a
research process....

1. Identify main ideas and X 5-LA-R-4,
supporting facts to select 6-LA-RPCP-6
relevant information to
answer questions.

North Canton City Schools has made this tool available on the Web for other districts to use. See Web link below. Included is the
technology standards implementation tool, instructions for using the tool, and a sample of the tool completed for sixth grade.
<www.northcanton.sparcc.org/~technology/standards/>

Other districts are doing similar things to implement the technology standards, and we will be sharing more on this topic throughout the
year.
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FALL 2005 NWOET

Course Date/Time/Location BGSU Sem. BGSU Credit Fees* Materials Total Cost w/
(See page 5 for descriptions) Hr(s). Credit(s) Fees** BGSU Credit

+ PD Fee

Classroom Curriculum Technology Framework - Mondays, Sept. 12 - Dec. 5, 2005 1, 2, or 3 TBD 1 session: $39 TBD
Three Modules 4:00 - 8:00 p.m., NWOET 2-5 sessions: $59
Werner, Dick, Davis & Tucker, Instructors 6-10 sessions: $99

11-15 sessions: $149

Digital Photography in the K-12 Classroom - Tuesdays, Nov. 1, 8, 15, 22, 2005 1 TBD $199 TBD
Dick & Werner, Instructors 4:00 - 8:00 p.m., NWOET Includes camera Includes
INCLUDES 3 megapixel CAMERA (Required at time of camera & all

registration) materials

Digital Photography in the K-12 Classroom - Tuesdays, Nov. 8, 15, 22, 29, 2005 1 TBD $199 TBD
Davis, Instructor 4:00 - 8:00 p.m., Includes camera
INCLUDES 3 megapixel CAMERA Lima City Schools (Required at time of

Location TBD registration)

Advanced Digital Photography in the Wednesdays, Jan. 11, 18, 25, 1 TBD $199 TBD
K-12 Classroom - Dick, Instructor Feb. 1, 2006 Includes software
INCLUDES Photoshop Elements 3.0 for Mac or 4:00 - 8:00 p.m., NWOET NO camera included
Windows (indicated when registering) (Required at time of

registration)

Classroom Technology for Teachers - Orientation: Wed., Sept. 7, 2005 3 TBD $149 TBD
Online course - Bell, Instructor 4:30 p.m. - 6:30 p.m., NWOET

(Course ends Dec. 2, 2005)

Effective Standards-based Teaching: Focus Class meetings, Tues., Sept. 13, 1 or 3 TBD Register by calling TBD
on Science 7-12  - Davis & Jackson, Instructors Sept. 27, 2005 NWOSERRC at
**Web-enhanced** (Plus Oct. 25 for 3 credit hours) 800-346-8495
SESSION 1 - Sept. 13 - Nov. 16, 2005 4 p.m. - 9 p.m., NWOET

Effective Standards-based Teaching: Focus Class meetings, Wed., Oct. 12, 1 or 3 TBD Register by calling TBD
on Science 7-12  - Davis & Jackson, Instructors Tues., Nov. 1, 2005 NWOSERRC at
**Web-enhanced** (Plus Dec. 13 for 3 credit hours) 800-346-8495
SESSION 2 - Oct. 12 - Dec. 15, 2005 4 p.m. - 9 p.m., NWOET

EDIS 684. Assistive Technology Fundamentals - Oct. 17 - Nov. 23, 2005 1 TBD $20 plus materials TBD
Online course 100% ONLINE

In cooperation with Bowling Green State University

Fall 2005                                          For more information call 800-966-9638 or visit www.nwoet.org/hqpd

Educational Technology

N o r t h w e s t  O h i o

NWOET

Professional Development

A Pull-Out-And-Save Page

Trainings listed above will be held at NWOET, 245 Troup Ave., Bowling Green, or as indicated.  See http://www.nwoet.org/about/map.htm for driving
directions to NWOET. Certificate of attendance available for all trainings on request at completion of course if not taking course for grad credit.

*   At press time, BGSU Graduate Credit fees for Fall Semester 2005 had not been determined.  Call or consult the NWOET Web page (www.nwoet.org)
for details.  Grant funding provided through NWOET and partner organizations allow these courses to be offered for graduate credit through Bowling
Green State University at a reduced cost.  Courses may or may not apply for degree completion.  Contact NWOET or your graduate advisor for more
information.

** Non-credit/Materials fee for NWOET members; non-members - call for pricing. Payable to NWOET by check, cash, or district purchase order at time
of registration.

TBD= to be determined

Call 800-966-9638 for more information or to register.
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Classroom Curriculum Technology
Framework: Technology Skill Modules
Enroll in one session or all three modules
of trainings that consist of hands-on
activities for the purpose of developing a
variety of technology skills to support
classroom curriculum and technology
integration. Prerequisite: None

Module I: Productivity Tools
Mon., Sept. 12 Tips and Tricks with

Microsoft Word
Mon., Sept. 19 Introduction to Excel
Mon., Sept. 26 Classroom Applications

for Word and Excel
Mon., Oct. 3 Using an Interactive

Whiteboard

Module II: Internet Resources
Mon., Oct. 17 Enhanced Instruction

with Video Streaming
Mon., Oct. 24 Classrooms Internet

Resources
Mon.. Oct. 31 Exploring INFOhio

Resources
Mon., Nov. 7 Creating Content-based

WebQuests

Module III: Multimedia Tools
Mon., Nov. 14 Introduction to Digital

Cameras
Mon., Nov. 21 Photoshop Elements

Basics
Mon., Nov. Putting Pow! Into

PowerPoint
Mon., Dec. 5 Concept Mapping

Digital Photography in the K-12
Classroom
Digital cameras have extensive uses and
often motivate educators to integrate
technology effectively in their curriculum.
This course is intended to provide partici-
pants with a secure knowledge of basic
digital camera operation, as well as
introduce them to effective methods for
curriculum integration. The use of photo
editing in this training will provide an
avenue for the manipulation of digital
images. Materials fees include a digital
camera. Prerequisite: None

Advanced Digital Photography in the K-12
Classroom
* Offered by request *
Taking the use of digital cameras and
photo editing to the next level, this course
is developed for the intermediate and
advanced users. Features of Photoshop
Elements 3.0 will be explored. Printing
options of digital images will also be
demonstrated. Materials fees include
Photoshop Elements software. Prerequisite:
Digital Photography in the K-12 Class-
room or permission of the instructor.

Classroom Technology for Teachers
The focus of this online course is to
provide practical experiences with the
implementation of a variety of technology
skills for the educator at the beginning
level of technical ability. Throughout the
course, participants will develop skills in
the use and implementation of technology
tools that will permit them to provide
similar opportunities for their students.
Prerequisite: None

Effective Standards-based Teaching:
Focus on Science (7-12)
**Choose from 2 Sessions Fall Semester **
This Web-enhanced course will have two
(three for 3 credits) face-to-face meetings
as well as Web-delivered instruction. The
main focus will be to deepen the content
knowledge of educators in 7-12 science
instruction. Participants will have hands-on
experiences with a variety of video and
Web multimedia tools. Content areas
include life and physical sciences, science
experiments, and science discussion
boards. This course will provide 45 hours
of instruction in science content that is
designed to lead to highly qualified teacher
status in science. Note: This course alone
may not earn an educator highly qualified
teacher status in science. Consult your
district administration.

EDIS 684. Assistive Technology
Fundamentals
This course provides educators with an
overview of assistive technology in the
areas of communication, mobility, educa-
tion, recreation, vocation, independence
and therapy/rehabilitation.  Emphasis is on
developing an awareness of the diversity of
assistive technology currently available.

NWOET Professional Development Descriptions

EDIS 684. Augmentative Communication
Assessment (1) - Staff
Dates TBA
1 semester hour BGSU graduate credit

EDIS 684. Augmentative Communication
Systems (1) - Staff
Dates TBA
1 semester hour BGSU graduate credit

EDIS 684. Providing Speech Output for
ASD (1) - Staff
Dates TBA
1 semester hour BGSU graduate credit

EDIS 684. Providing Visual Supports in
Communication for ASD (1) - Staff
Dates TBA
1 semester hour BGSU graduate credit

EDIS 684. Seating and Positioning to
Promote Activity (1) - Staff
Dates TBA
1 semester hour BGSU graduate credit

EDIS 684. Sensory Processing: Theory
and Application (1) - Staff
Dates TBA
1 semester hour BGSU graduate credit

EDIS 684. Team Problem Solving and
Decision Making - Staff
Dates TBA
1 semester hour BGSU graduate credit

Preregistrations are being
accepted now for the

following classes:

Attention
Grad Students!
Due to changes in state
funding, the one credit
EDIS 684 courses may or may
not be offered in the future.
Please plan accordingly.

☞

Online Graduate
Courses

Credit and Non-Credit Courses.
For more information call
800-966-9638.



Phone: 1-800-966-9638          Email: nwoet@nwoet.org          Web: www.nwoet.org6

Tech Tips & Tricks

Computer Cleaning
By Tonya Koenig

Now that the school year is begin-
ning, it is an excellent time to think
about cleaning up your PC. If your
machine is managed by a technology
coordinator, an option is to have he/she

re-image the machine and it will be just like new. Of course, make
sure that you back up all your documents and files that you will
need in the future.

If your technology coordinator does not have an image for your
machine, then you can do several things to make your machine run
better.

1. Delete any programs you no longer need.  Go to the start
menu, control panel, and then click on add or remove programs.
Select the program you want to remove and uninstall it. Sometimes
this does not remove the entire program, so you may need to click
on My Computer, your local disk, and then program files. In this
folder, look for the folder of the program you just uninstalled and
delete the folder.

2. Remove any .tmp or .gid files. If you do a search (start and
then search) for *.tmp and *.gid files, all the files with those
extensions on your machine will appear. After the search is
completed, right click on each file and select delete. After all files
are deleted, then empty your recycle bin.

3. Run Disk Defragmentor on your machine. Go to start, all
programs, accessories, system tools and then select disk defragmen-
tor. Then click on defragment. This will organize the files on your
machine and eliminate any deleted files. This will allow your
machine to run more smoothly. It would probably be best to run this
overnight to eliminate any lagging of performance.

Other basic computer maintenance procedures can be imple-
mented with your PC. These will be covered in a future article. If
you need assistance with any of these steps, feel free to contact our
offices at 1-800-966-9638.

Quick Tips on Editing Pictures in Adobe Photoshop
Elements
By Jessica Beck

First, open the Photoshop Elements program and click open
when the menu bar comes up for the options at the start of the
program. Find the picture that you would like to edit, and then click
open.

One way to quickly and easily enhance your picture would be to
go up to the tool bar and click Enhance/Auto Levels. This will
automatically set the color levels to allow for a better quality
picture.

If you would like to crop out empty space or unwanted sections
of the picture, you can use the crop tool which is located on the tool
bar on the left of the screen and the third button down on the left
side of tool bar. If you are not sure you have selected the right tool,
run your mouse over the buttons to find the one that says “Crop
Tool.” Once you have clicked on the crop tool, place your mouse in
the upper left hand corner of the portion of the picture that you
want to keep, and drag it down to the lower right hand corner of the
portion. While doing this always keep your finger down on the

mouse. If you are satisfied with your selection, click the crop tool
again and it will ask if the computer should crop it or not. Select
Crop, and your picture will be cropped.

Another way to enhance your picture is by going under Enhance
on the tool bar, Brightness/Contrast, and then Levels. Here you will
have control over the three colors that make up the picture, red,
green and blue. When it pops up, scroll down on the Channel Bar
and select red. There will be a graph below the Channel scroll bar
showing the different levels of red in the picture. Move the arrow to
the farthest left to the place where the graph first starts to increase
the red drastically. Move the arrow to the farthest right to the place
where the graph makes its final drastic decent. Repeat these steps
for green and blue as well. This will enhance the color levels within
your picture.

Tips for Making a Good PowerPoint Better
By Jessica Beck

• Do not clutter your PowerPoint with unnecessary gif files or
“bells and whistles.” In other words, do not use the sound options
provided in PowerPoint unless they are used sparingly and in good
taste.

• If you decide to use one of the design templates provided by
PowerPoint for your slides and would like to use different fonts and
colors to go along with the theme, you do not have to be a master of
matching colors to achieve this. PowerPoint already has pre-
selected colors that will correspond nicely with the template you
have chosen. For example, if you want to change your font, choose
your preferred template, click on the text box, then in the menu bar
select Format>Font. When you click on the Color box in the font
window, a row of colors will come up that correspond with your
template.

• It is always nice to add a consistent transition effect for all
your slides when you are finished with your PowerPoint. To do this
go to the menu bar and select Slide Show>Slide Transition. A
window will pop up on the right hand side with your choices. Some
popular ones to use are the Fade Through Black transition and the
Wheel Clockwise transition. To preview your choice, press F5 on
your keyboard. If you feel the speed of your transition moves too
fast, you can change it using the same window that came up on the
right when you first chose your transition. It should be under
Modify Transition which is located right under the transition
choices. After the transition is how you want it, click Apply to All
Slides in the lower right hand corner to keep them consistent.

• If you want to add a video to your PowerPoint, the only file
format you can use that you can insert directly into the presentation
is an .avi movie file. If your video is in a different format, you can
link it to your presentation. You must be certain to bring it along
with you when you present because it is not a part of the Power-
Point; it is just linked, and a separate file.

• To make the titles of your slide more appealing you can use an
option called Word Art. To use this option go to the menu bar and
select Insert> Picture> WordArt. Choose a style and click OK. Then
you can type in your desired text, push OK, and PowerPoint will
create it for you. Once it is created, a WordArt menu bar should pop
up giving you options to change the way your WordArt looks with
choices in the format (color; line style, thickness and color)
spacing, shape, and orientation (vertical or horizontal running text).
If it does not show up, you can manually bring it up by going to the
menu bar and selecting View>Toolbars>WordArt.
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Media Center
By Phyllis Hartwell

Welcome back! Hope your summer was restful and uneventful. We
will be sending out catalogs this year because many of the teachers said
they liked to have a hard copy. Those will be sent to the librarian or media
specialist so check with them if you are interested in a copy. Please let us
know if e-mail or building addresses have changed over the summer.

Below are some series that may peak your interest.

What’s the Verdict
The first series is What’s the Verdict Series. There are eight videos that will guarantee to

stimulate some interesting classroom discussions. This will give the students an opportunity
to develop their own opinions while following a real case.  The age level is junior and senior
high. Copyright 1999.
25039 Perzian vs O’Connor
25043 Kolokouris
25046 TN vs Rouse
25083 Dangler vs Yorktown
25047 Stop Sign
25048 Letourneau/Jonesboro
25050 Provensino
25049 Gregory K

Unseen Life on Earth: An Introduction to Microbiology
The second series is entitled Unseen Life on Earth: An Introduction to Microbiology.

It is recommended for the senior high level. Copyright 1999.
25019 Metabolism
25020 Reading the Code of Life
25021 Genetic Transfer
25022 Microbial Ecology
25023 Microbial Diversity
25024 Microbial Evolution
25025 Microbial Control
25026 Microbial Interactions

Voices in Democracy
The third series is entitled Voices in Democracy. It is also recommended for senior

high. Copyright 1998.
25196 Democratic Voices in a Changing Society
25197 Living Constitutioin
25198 Constitution Crisis
25199 Federalism
25200 Public Opinion and Political Socialization
25201 Participation in Democracy
25202 Mass Media and the Government
25203 Interest Groups
25204 Political Parties
25205 Media and Elections
25206 Congress
25207 Legislative Process
25208 Congress and the President
25209 Domestic Policy
25210 Foreign Policy
25211 Federal Court
25212 Criminal Justice
25213 Due Process of the Law
25214 First Amendment Freedoms
25215 Struggle for Equal Rights
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2004-2005
Broadcast Schedule

The 2004-2005 Instructional
Television (ITV) schedule is
available on the NWOET website at
<www.nwoet.org>. Click on Media
Resources.

ITV Series Drops
The copyright has expired for the

following Instructional Television Series.
They should be removed from your shelves.

Bill of Rights in Action
More Books Cover to Cover
North American Biomes

ITV Series Adds
For more information about the

following series, see Tape Duplication at
<www.nwoet.org/media>

Animal Babies: Born Wild
Earth in Action
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Former NWOET Tech Conference Sessions Included:

October 10, 2005
8:30 a.m. - 3:30 p.m.

Northwood High School, Northwood, OH

• Hands-On sessions:
PhotoShop
FrontPage
Digital Images
PDA’s for the Classroom

• Tips and Tricks in Word XP

• A Multimedia Curriculum for “Safe Passage: The Under-
ground Railroad”

• A Multimedia Curriculum for “Antarctica: 90 Degrees
South”

• Making Technology Work for You and Your Students

• Video Streaming Services from NWOCA

• Finding a PLACE in Staff Development

• Video Production of the Redskins Weekly News

• Successful, Practical Technology Integration Across the
Curriculum

• Online Course Offerings from NwOESC for Staff and
Students

The 2005 NWOET Tech Conference +
in cooperation with Northwood Local Schools

will offer high quality professional development at a convenient location.

More information on-line at <www.nwoet.org/conference>.

Plan to
attend now!

Send topic suggestions to: tucker@nwoet.org

Customized topics to
meet the needs of
your staff, including:
• STRS Awareness

• NCLB 8th Grade Technology
Assessment

• College Technology Skills Assessment

Registration Rates:
$  99 per person (includes certificate for

contact hours)

$  69 per person for groups of 5 or more
from a district

$349 BGSU graduate credit option -
1 semester hour. (Includes Tech
Conference registration, tuition, all
materials, and requires attendance
at two skill module sessions plus
completion of course project).
For details, call 800-966-9638.

Complimentary continental breakfast.
Lunch available for purchase on site.

Educational Technology
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NWOET

Register at <nwoet.org/conference/reg_form.asp> or call 800-966-9638.


